
About
Gives copyright and author information on the program.



Add Bar Code Objects
Puts the program into Add Bar Codes mode.



Add Ellipse Objects
Puts the program into Add Ellipses mode.



Add Headline Objects
Puts the program into Add Headlines mode.



Add Line Objects
Puts the program into Add Lines mode.



Add Picture Objects
Puts the program into Add Pictures mode.



Add Rectangle Objects
Puts the program into Add Rectangles mode.



Add Rounded Rectangle Objects
Puts the program into Add Rounded Rectangles mode.



Add Text Objects
Puts the program into Add Text mode.



Append New Page
Appends a new page after the current page in the current document.



Arrange Icons
Arranges the icons of any minimized windows at the bottom of the screen.



Banner Font dialog box
Select the font that you want to use for the banner.    Note that it is not necessary to select a font size -- the program 
will determine the font size automatically.



Banner Text dialog box
Enter the text that you want to appear on the banner.



Bar Code Object
A bar code object contains a bar code that can be scanned.



Bar Code Object Properties dialog box
This dialog box is where you change the appearance of bar code objects.

Center Horizontally
Check this box if you want the bar code object to always center itself horizontally.

Center Vertically
Check this box if you want the bar code object to always center itself vertically.

Show Text
Check this box if you want the text associated with the bar code object to show up next to it.

Use Database Field
Check this box if you want the bar code object to use a database field for its data.

Bar Code Type
Select the type of bar code that you want the bar code object to use.

Data
Type in the text that is associated with the bar code object .

Sample Data
Gives an example of correctly formatted text for the bar code object.    Note that if you do not type in text that 
conforms to this format, the bar code object may not appear.

Database Field
Select the field from the current document's database that you want the    bar code object to use for its data.

Default
Check this box to keep the current attributes as the default.

OK
Press this button to accept the changes made to the bar code object.

Cancel
Press this button to cancel the changes made to the bar code object.

Help
Press this button to get help on this dialog box.



Border dialog box
The Border dialog box is where you decide what kind of border a text object will have.

Color
Click on the color that you want the border to be.

Size
Type in the size (in pixels) of the border.    If you type in 0, no border will appear. 

OK
Press this button to accept the changes made to the border.

Cancel
Press this button to cancel the changes made to the border.

Help
Press this button to get help on this dialog box.



Bottom button bar (text object formatting)
The controls on this bar are used for formatting text objects.    The controls will be active when a text object is the 
selected object.    From left to right, the controls are: Change font, change font size, bold, italic, underline, left 
justify, right justify, center justify, justify both, left justified tab stop, right justified tab stop, decimal justified tab 
stop, and center justified tab stop.



Bring To Front
Puts the selected object on top of all of the other objects (other than text objects) on the current panel.



Business Card Type dialog box
Connected
Press this button to select business cards that print out connected to each other.

Separated
Press this button to select business cards that print out in two separated columns.

Cancel
Press this button to close the dialog box without choosing a business card type.

Help
Press this button to get help on this dialog box.



Cascade
Arranges the windows in a cascading    (overlapped and slightly offset) format.



Center Horizontally
Centers the selected object horizontally on the object's panel.



Center Vertically
Centers the selected object vertically on the object's panel.



Change Banner Width
If the current document is a banner, this will allow you to change the width of the banner.



Change Business Card Type
If the current document is a business card, this will allow you to change the type of business card.



Change Label Type
If the current document is a label, this will allow you to change the type of label.



Clear Form
Clears all of the field objects on a form.



Close
Closes the current document.    If the current document has not been saved, you will be prompted to save it. 



Contents
Takes you to the help’s Table of Contents.



Copy
Copies the selected object to the clipboard so that it can be pasted into a document.



Current Page
The page of the current document that is on the screen.



Current Panel
The current panel is the panel that the selected object is on.



Current Document
The current document is the document that is currently showing.    If more than one document is showing, the 
current document is the one with the highlighted title bar.



Cut
Deletes the selected object, but saves it in the clipboard so that it can be pasted back into a document.



Delete
Deletes the selected object.



Delete Current Page
Deletes the current page in the current document.



Down One Level
Exchanges the selected object with the object directly below it (unless the selected object is a text object).



Edit Custom Dictionary
Brings up the Edit Custom Dictionary dialog box, which allows you to modify the custom dictionary.



Edit Custom Dictionary dialog box
Allows you to modify the custom dictionary.    Any words so that are in the custom dictionary will be treated as 
being correctly spelled.



Edit Description dialog box
Enter new description
Type in a new description for the existing template.

OK
Press this button to accept the new description.

Cancel
Press this button to cancel the new description.

Help 
Press this button to get help on this dialog box.



Edit Menu 
The Edit Menu has choices for manipulating objects with the program's clipboard (the Windows® clipboard is used 
for cutting and pasting text with text objects).

Cut

Copy

Paste

Delete

Select All



Edit Objects
Puts the program into Edit mode.



Ellipse Object
An ellipse object contains an ellipse and a border that can be resized.



Exit
Exits the program.    You will be prompted to save any open, unsaved documents.



File Menu 
The File Menu has choices for creating, opening, saving, and printing documents, and exiting the program.

New

Open

Close

Save

Save As

Save As Template

Export To PDF

Change Document Type/Description

Change Label Type

Change Banner Width

Change Business Card Type

Print Preview

Print

Print Setup

Acquire

Select Source

Send

Exit

Open Previously Used Document/Clear File List



Fill In Form
Allows you to fill in the fields of a form.



Font dialog box
The Font dialog box is where you choose a font to use with text objects.

Font
Choose the name of the font that you want to use.    Try to use TrueType™ fonts whenever possible (the ones with 
the TT symbol) because they will make your printed document look more like the one on the screen than other fonts.

Font Style
Changes the basic "look" of a font.

Size
Set the size (in points) that you want the font to be.    A point is 1/72 inch.

Strikeout
Draws a line through the middle of the letters in the font.

Underline
Underlines letters in the font.

Color
Changes the color of the font.    Some colors may not show up well on black and white printers.

Sample
Shows what the resulting font will look like.

OK
Press this button if you are satisfied with your choice of font.

Cancel
Press this button if you want to return to using the previous font.

Help
Press this button to get help on this dialog box.



Go To Page
Brings up the Go To Page dialog box, which prompts you to enter a page number in the current document to go to.



Go To Page dialog box
Prompts you to enter a page number in the current document to go to, after which the page that you entered will be 
the current page.



Grid
The grid is an optional part of each document's display.    The grid is used to make the justification of objects easier 
by providing a backdrop to move the objects around on.    The grid size can be changed to provide different levels of 
resolution, and the grid can be set up so that objects will align on it.



Grid Object Properties dialog box
The Grid Object dialog box is where you change the appearance and arrangement of text in grid objects.

Grid Color
Press this button to bring up the dialog of color choices for the grid object.

Line Color
Press this button to bring up the dialog of color choices for grid lines.

Line Size
Set the thickness that you want the grid lines to be.

Number of rows
Set the number of rows you want in the grid object.

Move current row
Check this if you want to move the text in the current row up or down. Then choose which direction and set how 
many rows to move.

Number of columns
Set the number of columns you want in the grid object.

Move current column
Check this if you want to move the text in the current column right or left. Then choose which direction and set how 
many columns to move.

Font Name
Choose the name of the font that you want to use.    Try to use TrueType™ fonts whenever possible (the ones with 
the TT symbol) because they will make the text look more like the one on the screen than other fonts.

Font Size
Set the size (in points) that you want the font to be.    A point is 1/72 inch.

Font Style
Choose any combination of font styles, bold, italic, and underline.

Font Justification
Choose which justification you want the text to have, left, center, or right.

Font Color
Press the Color button to bring up the dialog of color choices for the text in the grid object.

Center Horizontally
Check this box if you want the grid object to always center itself horizontally.

Center Vertically



Check this box if you want the grid object to always center itself vertically.

Default
Check this box to keep the current attributes as the default.

OK

Press this button to accept the changes made to the grid object.

Cancel

Press this button to cancel the changes made to the grid object.

Help

Press this button to get help on this dialog box.



Grid Size
Brings up a submenu that allows the user to set the grid size.    The grid size ranges from 1/32" to 1" (2 mm to 25 
mm if you are using the Metric system).    The current grid size is shown in this menu item, and is checked in the 
submenu.



Headline Object
A headline object is a block of text that can use different fonts, justification, colors, textures, shadowing and 
highlighting to give the effect that you want.



Headline Object Properties dialog box
The Headline Object dialog box is where you change the contents and appearance of headline objects.

General

Text
Type in the text of the headline object.    If you want to end a line before it wordwraps, press the Enter key where 
you want the line to end.    To enter text that can be personalized, surround a descriptive word or two with square 
brackets (example: [First Name]).

Insert Database Field
When connected to a database, press this button to choose a field in the database. The text for that field will then be 
displayed in the project.

Revert
Press this button to revert back to the attributes of the headline object before any changes were made using this 
dialog.

Delete Blank Lines
Check this box if you do not want to show any lines of text that are blank.

Center Horizontally
Check this box if you want the text of the headline object to always center itself horizontally.

Center Vertically
Check this box if you want the text of the headline object to always center itself vertically.

Default
Check this box to keep the current attributes as the default.

OK

Press this button to accept the changes made to the headline object.

Cancel

Press this button to cancel the changes made to the headline object.

Help

Press this button to get help on this dialog box.

Preset Styles
Choose a style from one of the installed set or create and arrange your own set.

Add
Press this button to add the current    attributes to the list of Preset Styles.



Delete
Press this button to delete the selected style from the list of Preset Styles.

Replace
Press this button to replace the selected style with the current attributes.

Move Up
Press this button to move the selected style up one in the list of Preset Styles.

Move Down
Press this button to move the selected style down one in the list of Preset Styles.

Customize
Choose this to customize the currently selected style.

Font Name
Choose the name of the font that you want to use.    Try to use TrueType™ fonts whenever possible (the ones with 
the TT symbol) because they will make your printed card look more like the one on the screen than other fonts.

Font Size
Set the size (in points) that you want the font to be.    A point is 1/72 inch.

Font Style
Choose any combination of font styles, bold, italic, and underline.

Font Justification
Choose which justification you want the text to have, left, center, or right.

Font Solid Color
Choose this if you want the text to have a solid color. Press the Color button to bring up the dialog of color choices.

Font Gradient Color
Choose this if you want the text to have a gradient color. Choose Horizontal if you the color to go from left to right. 
Choose Vertical if you want the color to go from top to bottom. Press the From Color button to bring up the dialog 
of color choices for the starting color. Press the To Color button to bring up the dialog of color choices for the 
ending color.

Font Texture
Choose this if you want the text to have a particular texture. Press the Browse button to bring up a dialog to choose 
one of the installed textures or an image file.

Shadow / Highlight Color
Press this button to bring up the dialog of color choices for the Shadow or Highlight color.



Shadow / Highlight Style
Choose Plain if you want the Shadow or Highlight to only be at the current Depth and Direction in the current 
Shadow or Highlight Color. Choose Extrude if you want the Shadow or Highlight to start at the text and extrude out 
to the current Depth and Direction in the current Shadow or Highlight Color.    Choose Graduate if you want the 
Shadow or Highlight to start at the text in the current Font Color and extrude out to the current Depth and Direction 
ending in the current Shadow or Highlight Color.

Shadow / Highlight Direction
By clicking on one of the dots in the circle, choose which direction you want the Shadow or Highlight to be. 
Clicking on the dot in the center of the circle will turn off the Shadow or Highlight.

Shadow / Highlight Depth
By moving the slider, choose the depth of the Shadow or Highlight.

Background Transparent
Choose this if if you want to have a clear background.

Background Solid Color
Choose this if you want the background to have a solid color. Press the Color button to bring up the dialog of color 
choices.

Background Gradient Color
Choose this if you want the background to have a gradient color. Choose Horizontal if you the color to go from left 
to right. Choose Vertical if you want the color to go from top to bottom. Press the From Color button to bring up the 
dialog of color choices for the starting color. Press the To Color button to bring up the dialog of color choices for the 
ending color.

Background Texture
Choose this if you want the background to have a particular texture or image. Press the Browse button to bring up a 
dialog to choose one of the installed textures or an image file.

Border Color
Press this button to bring up the dialog of color choices for the border color.

Border Size
Set the thickness that you want the border to be.



Help
You can get help at any time by pressing the F1 key.    You can also press the help button (the one with the red 
question mark) while in the main window, or press the help button (the one marked "Help") while in a dialog box.    
Pressing F1 while a menu item is highlighted will give you help on that menu item.    Pressing F1 while not in a 
menu or pressing the button with the red question mark will show you the help's Table of Contents.    Pressing F1 
while in a dialog box or pressing a help button will give you help on the current dialog box.



Help Menu
The Help Menu accesses the program’s on-line help.

Contents

Topic Search

How To Use Help

About



How To Use Help
Shows you help on the Windows® help system.



Image Operations dialog box
The Image Operations dialog box has four parts which can be accessed separately by clicking on the tabs at the top 
of the dialog box.    The four parts are:

Information
Displays information about the current image.

Colors
Allows you to change the color format of the image.    Checking Gray Scale will remove all color information from 
the image.    Checking Dithering will use dithering (combining two existing colors in a pattern to form what looks 
like a new color) in video modes with only 16 or 256 colors.

Effects
Allows you to try different visual effects to change the image.    Checking Red, Green, and/or Blue will apply the 
effect to only the checked color(s).    If you choose the Brightness effect, you will also need to choose a value on the 
slider from -100 to 100.

Transform
Allows you to flip and rotate the image.    For certain flip/rotation choices, you will need to make other choices:

Choose the angle to rotate the image.

Checking Clip Corner will keep the image the same size, clipping any part of the image that is rotated outside of its 
original bounds.

Pressing the Background Color button will open a dialog box allowing you to choose the color that fills in the 
background when the image is rotated.

The buttons at the bottom of the dialog box are:

Preview
Shows what the image will look like with the changes that you have made.

OK
Saves the changes that you have made and exits the dialog box.

Cancel
Cancels the changes that you have made and exits the dialog box.

Help
Press this button for help on this dialog box.



Insert New Page
Inserts a new page before the current page in the current document.



Introduction
This program allows you to create an unlimited amount of documents for many occasions.    You can use the clip art 
included with the program or your own clip art or fonts to make your own specialized documents.    You can create 
generic document templates that can be personalized for different occasions or people. You can create an event 
database that will prompt you to create documents at the correct time of the year.    And you can do all this quickly 
and easily.

Useful terms
The following are some terms that are used repeatedly in the help:

Current Document

Object

Text Object

Headline Object

Picture Object

Line Object

Rectangle Object

Rounded Rectangle Object

Ellipse Object

Bar Code Object

Object Handles

Selected Object

Panel

Current Panel

Mode



Line Object
A line object contains a line of a selected color, style, and size.



Line Object Properties dialog box
This dialog box is where you change the appearance of line objects.

Color
Click on the color that you want the line drawn in.

Style
Click on the style that you want the line drawn with.    Note that styles other than Solid cannot be used if the line 
width is greater than 1

Center Horizontally
Check this box if you want the line object to always center itself horizontally.

Center Vertically
Check this box if you want the line object to always center itself vertically.

Width
Type in the width (in pixels) of the line.    If you type in 0, the line will always have a width of 1, regardless of the 
current zoom level.

Default
Check this box to keep the current attributes as the default.

OK
Press this button to accept the changes made to the line object.

Cancel
Press this button to cancel the changes made to the line object.

Help
Press this button to get help on this dialog box.



Link Text Objects
This will allow you to link two text objects so that text from the first object will flow into the second one.    The 
program will be put into Link From mode.    Left click on the first text object to link, or right click to return to Edit 
mode.    After left clicking, left click on the second text object to link, or right click to return to Edit mode.    If you 
click on the same text object twice, this will cancel any link that the object currently has.



Locked
If checked, the selected object cannot be moved or resized.    When this menu item is chosen, the locked state of the 
selected object is toggled on or off.



Main Window
The main window is where you edit the current document.

You can create a new object by first clicking on one of the mode buttons on the top button bar corresponding to the 
type of object that you want to create.    Then, hold down the left mouse button and drag the mouse to draw a shape 
that shows the outline of the object that you want.    When you are happy with the outline, release the left mouse 
button.    For objects other than text objects, you will then see a dialog box that will let you change the properties of 
the new object.

You can select an object by clicking on it with the left mouse button.    If more than one object is under the mouse 
cursor when you click, the top object will be selected.    You can select an additional object by holding down one of 
the shift keys when you click.    For a text object, you may have to move the mouse cursor to the outside edge of the 
object (where the mouse cursor will change to an arrow) before you can select it.    You can also select a group of 
objects in Edit mode by holding down the left mouse button outside of any objects, dragging the mouse to form a 
rectangle that encloses at least a part of any objects that you want to select, and releasing the left mouse button.

Once an object is selected, you can move it around on the current document by dragging it with the left mouse 
button.    The mouse cursor will change to a hand to show when it is in the correct position to move the object.    For 
text objects, the mouse cursor will only change to a hand when you move it to the outside edge of the object.

You can resize an object by dragging one of the object's handles.    The mouse cursor will change to a two-headed 
arrow (or four-headed arrow for line objects) to show when it is in the correct position to resize the object.    The 
arrowheads will show in which directions the object can be resized.

Headline objects can only be resized to make them wider or thinner, not shorter or taller.    The height of a headline 
object is based on the width of the object and how the text wraps within that width.

Line objects can be forced to be straight while being created or resized by holding down a Shift key or a Ctrl key 
while dragging the mouse.    Holding down a Shift key will force the line to be vertical, and holding down a Ctrl key 
will force the line to be horizontal.

You can access a pop-up menu of commands to perform on an object by right-clicking on the object.



Menu Bar
The menu bar lets you choose commands to help you create your document.    The individual menus and commands 
are discussed in the Menus section of the help.



Menus
File Menu

Edit Menu

View Menu

Page Menu

Object Menu

Web Menu

Personalize

Tools Menu

Window Menu

Help Menu



Middle button bar (panel views)
Each button on the left side of the bar allows you to see the current document in a different way.    The picture on 
each button corresponds to a panel or panels of the current document that you can view and edit.    When you click 
on a button the program will switch to the button's view of the current document.    You can see help for each button 
just like you did for the top button bar.



Minimize All
Minimizes all windows.



Mode
The program can be in one of several modes, which determines what a mouse click on the main window will do.    
You can tell which mode you are in by looking at the mouse cursor (except when the mouse is over a selected text 
object, in which case the mouse cursor will be an I-beam).    The modes (and their mouse cursors) are as follows:

Edit (an arrow)
Add Headlines (a letter "A" with a cross)
Add Text (a page of text with a cross)
Add Pictures (a page of various shapes with a cross)
Add Lines (a line with a cross)
Add Rectangles (a rectangle with a cross)
Add Rounded Rectangles (a rounded rectangle with a cross)
Add Ellipses (an ellipse with a cross)
Add Bar Codes (a bar code)
Add Combs (a comb shape)
Add Grids (a grid)
Add Fields (a rectangle with a cursor in it)
Move (a grabbing hand)
Link From (a large page of text linking to a small page)
Link To (a small page of text linking to a large page)



New
Creates a new document.    You will be asked if you want to use a template (an existing document) to base your 
document on, or create a completely new document.    If you decide to use a template,    the Open Template dialog 
box will allow you to choose a occasion and description for the document so that you will have something to start 
with.    If you do not want to use a template, the Document Type dialog box will come up so that you can select a 
document type for the new document.    You can personalize the resulting document and change it as you wish.    All 
documents use letter-sized paper, or A4-sized paper if you are using the Metric system.



New Picture dialog box
The New Picture dialog box is where you decide which picture to put in a picture object.

File Name
Type in the name of the picture file that you want to load in the edit box .    Only existing files are valid.    
Underneath is a list box which lists the picture files in the current directory.    Clicking the left mouse button on a file 
name will put the file name in the File Name edit box.

List Files of Type
You can ignore this, as there is only one type of file (Pictures), although you can read in files with the extensions 
BMP, JPG, PCX, PNG, TGA, TIF, and WMF.

Directories
Lists the current directory, followed by a list box where you can change directories.    Double-click with the left 
mouse button on a directory name to make that directory the current one.

Drives
Bring down this list to choose a different drive to look for files on.

Preview
Check this box if you want to see each picture as it is selected in the File Name list box.

OK
Press this button if you are satisfied with the file name that you have selected.

Cancel
Press this button to stop trying to open a picture file.

Help
Press this button for help on this dialog box.



Next Object
Sets the selected object to be the next object.    The next object is defined as the object in the current panel that is on 
top of the selected object.    If there is more than one panel on the screen and the selected object is at the top, the 
selected object will be set to the bottom object in another panel.



Next Page
If the current document has more than one page, this will jump to the next page of the document.



Object
Every document is made up of objects.    Objects can be text objects, headline objects, picture objects, line objects, 
rectangle objects, rounded rectangle objects, or ellipse objects.    Objects are placed on the document to make it look 
like you want.    Objects can be placed on top of other objects, making other effects possible.



Object Handles
Objects can resized using the "handles" that appear around the edges of an object when it has been selected.    The 
handles look like black squares.    As the mouse cursor is moved over the handles, it changes to reflect the kind of 
resizing that the handle is capable of.



Object Menu 
The Object Menu changes the selected object, adds new objects to the current document, or links together two text 
objects.

Bring To Front

Send To Back

Up One Level

Down One Level

Locked

Center Horizontally

Center Vertically

Properties

Edit Objects

Add Text Objects

Add Headline Objects

Add Picture Objects

Add Line Objects

Add Rectangle Objects

Add Rounded Rectangle Objects

Add Ellipse Objects

Add Bar Code Objects

Link Text Objects



Open
Opens an existing document.    You will be prompted to choose the document to open from the Open Document 
dialog box.



Open Previously Used Document/Clear File List
Opens a document that was worked on previously (if a file name is selected) or clears the list of previously used 
documents (if Clear File List is selected).



Open Template dialog box
The Open Template dialog box is where you choose which template you will base a new document on.

Purpose List
Lists the possible purposes to pick a template from.

Template Description
Lists the descriptions of templates from the currently selected purpose. 

Delete Template
Deletes the currently selected template.

Template file name
Shows the name of the template's file, in case you want to edit the template directly.    Template files are in the 
TEMPLATE directory.

Template Shape
Shows the shape of the currently selected template.

Template Headline Text
Shows the headline text of all of the headline objects in the currently selected template.

Preview
Shows a small picture of the currently selected template.

OK
Press this button to accept the currently selected template.

Cancel
Press this button to not create a new document.

Help
Press this button to get help on this dialog box.



Open Document dialog box
The Open Document dialog box is where you decide which existing document to load into the program.

File Name
Type in the name of the file that you want to load in the edit box .    Only existing files are valid.    Underneath is a 
list box which lists the files in the current directory.    Clicking the left mouse button on a file name will put the file 
name in the File Name edit box.

List Files of Type
You can ignore this, as there is only one type of file.

Directories
Lists the current directory, followed by a list box where you can change directories.    Double-click with the left 
mouse button on a directory name to make that directory the current one.

Drives
Bring down this list to choose a different drive to look for files on.

OK
Press this button if you are satisfied with the file name that you have selected.

Cancel
Press this button to stop trying to open a file.

Help
Press this button for help on this dialog box.

Network
Press this button (if it exists) to connect to network directories on other computers.



Page Menu
The Page Menu has choices for manipulating the pages of a multi-page document.

Insert New Page

Append New Page

Delete Current Page

Go To Page



Panel
Each document (except for banners) has one or more panels, each of which contains objects.    A panel corresponds 
to a single page of the document after it has been folded.    You can view more than one panel at once.    The border 
between different panels is shown with a gray line.    The printable area of a panel (based on the selected printer) is 
the area of the panel inside any light blue lines.    In the case of posters, there is a single panel which contains all four 
pages that make up the poster.



Paste
Copies the object in the clipboard into the current document.    The object will appear as a selected object in the 
upper-left corner of the current document that you can move around on the screen.



Personalize 
The Personalize menu item will personalize the current document by asking you to enter specific information in 
places where general information was entered in the document.    When a document is created for a general occasion, 
you may want to use the document in many different cases.    To do this, you create a headline object in a way that 
tells the computer to prompt for specific information.    For example, instead of creating a headline object that says 
"In Business For 20 Years" you would create one that says "In Business For [years] Years".    When you choose the 
Personalize menu item, the program looks for all headline objects that contain words in square brackets, and 
prompts you to enter information corresponding to the words inside the square brackets using the Personalize dialog 
box.    In this example, the computer would prompt you to enter a value for "[years]".    If you typed in "10", the 
headline object's text would change to read "In Business For 10 Years".    Many of the template documents use this 
feature to speed up document creation.



Personalize dialog box
The Personalize dialog box is where you enter the personalized text for a document.

Original text
Shows the text before it has been personalized.

Enter personalized text for [???]
Type in the personalized text to replace [???] with.

OK
Press this button to accept the personalized text.

Cancel
Press this button to stop personalizing the document.

Help
Press this button for help on this dialog box.



Picture Object
A picture object contains a picture that can be resized and modified.    Note that your system should support more 
than 256 colors if you want good results using pictures with 256-color palettes.



Picture Object Properties dialog box
The Picture Object Properties dialog box is where you change the contents and appearance of picture objects.

Center Horizontally
Check this box if you want the picture object to always center itself horizontally.

Center Vertically
Check this box if you want the picture object to always center itself vertically.

New Picture
Press this button if you want to load in a new picture using the New Picture dialog box. 

Modify Picture
Press this button to make changes to the current picture using the Image Operations dialog box.

Restore to original size
Check this box if you want the picture object to be resized to its original size.

Default
Check this box to keep the current attributes as the default.

OK
Press this button to accept the changes made to the picture object.

Cancel
Press this button to cancel the changes made to the picture object.

Help
Press this button to get help on this dialog box.



Previous Object
Sets the selected object to be the previous object.    The previous object is defined as the object in the current panel 
that is underneath the selected object.    If there is more than one panel on the screen and the selected object is at the 
bottom, the selected object will be set to the top object in another panel.



Previous Page
If the current document has more than one page, this will jump to the previous page of the document.



Print
Prints the current document using the Print dialog box.    As the document is printing, you may receive instructions 
to flip the printed page over.    This step is necessary to make the document look correct after it is printed and folded. 
You will probably need to practice with certain document types to make them look correct.    Note that text objects 
cannot be printed on panels that print upside down.    If a text object is not going to print, a black rectangle will 
appear around the object while you are editing it, and the object will not show up on the print preview.



Print Preview
Shows what the current document will look like when it prints using the Print Preview dialog box.        You can use 
the Previous Page and Next Page buttons to see all of the pages in the current document.    For poster documents, 
text objects are too small to show up, so they will be visible as rectangles with a cross-hatch pattern.



Print Preview dialog box
This dialog box comes up when you want to see what a document will look like when it prints.    You will see both 
the front and back of the document as it will appear when printed.

Close
Press this button to close the dialog box.

Help
Press this button for help on this dialog box.



Print Setup
Changes the printer that you are using or sets up the current printer using the Print Setup dialog box.



Print Setup dialog box
The Print Setup dialog box lets you change the attributes of the currently selected printer.    This dialog box is 
different for every printer.    The standard controls are:

OK
Press this button when you are satisfied with the current printer setup.

Cancel
Press this button to restore the previous printer setup.



Print dialog box
This dialog box comes up just before you print a document.

Printer
Shows which printer is currently selected.

Print Range
Since you will always be printing an entire document, you can ignore this.

Print Quality
If your printer has different print quality modes, you can change the print quality by selecting one of the modes.

Copies
You should always leave this set to 1.

Collate Copies
Since you will always be printing one copy, you can ignore this.

OK
Press this button when you are ready to print.

Cancel
Press this button if you decide not to print.

Setup
Press this button to bring up the Print Setup dialog box.

Help
Press this button for help on this dialog box.



Program Window
The Program Window consists of a menu bar, three button bars, a ruler bar, a main window, and a status line with 
two parts.    The menu bar allows you to select menu items (detailed in the following sections).    The button bars let 
you execute commands by pressing a button.    The main window is the background on which other windows will 
appear.    The status line shows the currently selected panel of the current document and help text for each of the 
menu items and buttons.

Menu Bar

Top button bar (commands)

Middle button bar (panel views)

Bottom button bar (text object formatting)

Ruler Bar

Rulers

Main Window

Grid

Status line



Properties
Allows you to change the properties of the selected object (unless the selected object is a text object).    Different 
types of objects use different dialog boxes to change their properties:

Headline objects: Headline Object Properties dialog box
Picture objects: Picture Object Properties dialog box
Line objects: Line Object Properties dialog box
Rectangle objects: Rectangle Object Properties dialog box
Rounded rectangle objects: Rounded Rectangle Object Properties dialog box
Ellipse objects: Ellipse Object Properties dialog box



Rectangle Object
A rectangle object contains a rectangle and a border that can be resized.



Rounded Rectangle Object
A rounded rectangle object contains a rectangle with rounded corners and a border that can be resized.



Ruler Bar
The ruler bar is used to show and change the indents and tab stops in the current text object.    The top half shows the 
indents and tab stops, and the bottom half shows a ruler to help set the indents and tab stops.

At the left side of the ruler bar are two triangles.    The bottom triangle can be dragged to set the left indent.    The top 
triangle can be dragged to set the indent for the first line of a paragraph.

At the right side of the ruler bar is a large triangle.    It can be dragged to set the right indent.

In the middle of the ruler bar are the active tabs.    There are four different types of tabs: left justified, right justified, 
decimal justified, and center justified.    These tabs can be dragged to change their position.    While being dragged, a 
tab's current position is shown at the far left of    the ruler bar.    If a tab is dragged off of the ruler bar, it will be 
removed.    To place a new tab, press the button on the bottom button bar corresponding to the type of tab that you 
want to create, and then left click on the ruler bar at the position of the new tab.



Rulers
Rulers are optionally shown along the top and the left side of the current document so that it is easy to determine the 
placement of objects on the document.



Save
Saves the current document.    If this is the first time you have saved the current document, you will be prompted to 
give it a name in the Save Document dialog box. 



Save As
Saves the current document under a different name, using the Save Document dialog box.    You would use this to 
save a modified document but still keep the original document.



Save As Template
Saves the current document as a template that can be used to create other documents.    The advantage of saving a 
document as a template as opposed to just saving it is that templates are grouped by occasion and description, so that 
users can tell what the document is without opening it.    When you save a document this way you first save it as a 
normal document file (press the Cancel button in the Save Document dialog box if you want to save the document as 
a template only), and then you assign the document to a occasion and give it a description with the Save Document 
As Template dialog box.



Save Document As Template dialog box
The Save Document As Template dialog box is where you add your own documents to the group of built-in 
templates.

Purpose List
Lists the existing purposes.

Add Purpose
Press this button to add a new purpose to the group of purposes.

Delete Purpose
Press this button to delete a purpose from the group of purposes.

Document Description
Type in a description of the document that you want to add to the templates.

OK
Press this button to add the document to the templates.

Cancel
Press this button to not add the document to the templates.

Help
Press this button to get help on this dialog box.



Save Document dialog box
The Save Document dialog box is where you decide which file name to give to a document.

File Name
Type in a name for the document that you want to save in the edit box .    If you type in the name of an existing file, 
you will be asked if you want to overwrite the file before leaving this dialog box.    Underneath is a list box which 
lists the files in the current directory.    Clicking the left mouse button on a file name will put the file name in the File 
Name edit box.

Save File as Type
You can ignore this, as there is only one type of file.

Directories
Lists the current directory, followed by a list box where you can change directories.    Double-click with the left 
mouse button on a directory name to make that directory the current one.

Drives
Bring down this list to choose a different drive to save files on.

OK
Press this button if you are satisfied with the file name that you have selected.

Cancel
Press this button to stop trying to save a file.

Help
Press this button for help on this dialog box.

Network
Press this button (if it exists) to connect to network directories on other computers.



Select All
Selects all of the objects in the current document that are on the screen.



Selected Object
The selected object is the object that is highlighted with handles around it.    Since multiple objects can be selected at 
once, sometimes more than one object can be the selected object.



Send
Sends the current document as an image file via electronic mail.



Send To Back
Puts the selected object under all of the other objects on the current panel (unless the selected object is a text object).



Shadow dialog box
The Shadow dialog box is where you change the shadow properties of a text object.

Position
Set the position of the shadow in relation to the text.    Choose "None" for no shadow.

Color
Choose the color of the shadow.

Offset
Choose the offset (in pixels) of the shadow.    Larger fonts generally need a larger offset.

OK
Press this button to accept any changes that you have made to the shadow.

Cancel
Press this button to cancel any changes that you have made to the shadow.

Help
Press this button to get help on this dialog box.



Rectangle, Rounded Rectangle, and Ellipse Object 
Properties dialog box
These dialog boxes are where you change the contents and appearance of rectangle objects, rounded rectangle 
objects, and ellipse objects.

Color
Click on the color that you want the shape drawn in.

Clear
Check this box if you want a border only and not a filled shape.

Height = Width
Check this box if you want the height of the shape to be equal to its width.

Center Horizontally
Check this box if you want the shape to always center itself horizontally.

Center Vertically
Check this box if you want the shape to always center itself vertically.

Border Color
Click on the color that you want the border drawn in.

Border Size
Type in the size (in pixels) of the border.    If you type in 0, no border will appear. 

Default
Check this box to keep the current attributes as the default.

OK
Press this button to accept the changes made to the rectangle object, rounded rectangle object,    or ellipse object.

Cancel
Press this button to cancel the changes made to the rectangle object, rounded rectangle object, or ellipse object.

Help
Press this button to get help on this dialog box.



Show Grid
If checked, shows the grid on the screen.



Show Rulers
If checked, shows the rulers on the screen.



Snap To Grid
If checked, will move objects to the nearest grid point whenever they are moved or placed.



Spelling
Checks the spelling in all of the current document's text.



Status line
The status line shows two pieces of information:    The name of the current panel (in the left part) and help 
information (in the right part).



Contents
Introduction

Program Window

Help

Menus



Text Object
A text object is a block of text that can be formatted like the text in a word processing document.    The text can use 
any combination of fonts, tabs, and paragraph formatting.    More than one text object can be linked together, 
allowing a single block of text to be spread over multiple columns or pages.    Unlike other objects, text objects are 
always on top of all other non-text objects.



Text Object Properties dialog box
This dialog box is where you change the appearance of text objects.

Center Horizontally
Check this box if you want the text object to always center itself horizontally.

Center Vertically
Check this box if you want the text object to always center itself vertically.

Transparent Background
Check this box if you want the background of the text object to be transparent.

Default
Check this box to keep the current attributes as the default.

OK
Press this button to accept the changes made to the text object.

Cancel
Press this button to cancel the changes made to the text object.

Help
Press this button to get help on this dialog box.



Tile
Arranges the windows in a tiled    (non-overlapped) format.



Tools Menu
The Tools Menu has choices for working with the spelling checker and the AutoSave feature.

Spelling

Edit Custom Dictionary

AutoSave



Top button bar (commands)
The top button bar has buttons that correspond to menu commands.    When you click on a button, it performs the 
same command that the related menu item would have done.

The group of buttons to the left of the help button (the one with the red question mark) correspond to the first eight 
program modes.    Pressing one of these will put the program into the mode that the button represents.    Normally, 
the program switches back to Edit mode after you add a new object, but if you hold down a shift key at the same 
time that you press one of the buttons (other than the Edit mode button), that button will be "locked".    While the 
button is locked, it will not be released until you press one of the other buttons or link two text objects.

Currently disabled buttons are colored all in gray, and cannot be pressed.

If you need to know what a particular button does, move the mouse over it.    After a slight wait, a yellow box will 
pop up over the button that describes it.    This information will also appear on the status line.



Topic Search
Allows you to look up entries in the help alphabetically by name.



Up One Level
Exchanges the selected object with the object directly above it (unless the above object is a text object). 



View Menu 
The View Menu changes the view of the current document by zooming in to it or zooming out from it, changing the 
selected object, or changing the grid.

Zoom Out

Zoom In

Previous Object

Next Object

Previous Page

Next Page

Show Grid

Snap To Grid

Grid Size

Show Rulers



Window Menu 
The Window Menu arranges the program's windows on the screen.

Cascade

Tile

Arrange Icons

Minimize All



Zoom In
Zooms the view in to the current document.    The farthest view is 25%, and zooming in will change the view 
through the range 33%, 50%, 67%, 75%, 100%, 150%, 200%, and finally 250%.



Zoom Out
Zooms the view out from the current document.    The closest view is 250%, and zooming out will change the view 
through the range 200%, 150%, 100%, 75%, 67%, 50%, 33%, and finally 25%.



Document Type dialog box
The Document Type dialog box allows you to choose a new document's type.

Pick the type of document to create
Using the mouse or the arrow keys, select the document type you wish to create from the list.

Use Wizard
If enabled, press this button to start a wizard that helps you create the selected document type.

Use Template
If enabled, press this button to bring up the list of saved templates in the Open Template dialog box.

Blank document
If enabled, press this button to open a new blank document of the selected type.

Cancel
Press this button if you do not want to create a new document.

Help
Press this button for help with this dialog box.



Grid Object
A grid object is a table that can be used for arranging text. You can format the text, move or change the size of the 
columns and rows, or change the colors to create grids of all types.



Add Grid Objects
Puts the program into Add Grids mode.



Web Menu
This menu contains commands for creating and editing a Web site from the current project.

Publish To Folder

Preview Web Site

Page Name Properties

Link Properties



Link Properties dialog box
This dialog is where you make changes to the link properties of an object on the project.

Web Address or Document
Choose this if you want the selected object to be a link to a Web site or document, such as "www.awebsite.com".

E-mail Address
Choose this if you want the selected object to be a link to an e-mail address, such as "aname@acompany.com".

File on your computer
Choose this if you want the selected object to be a link to a text or graphic file on your computer. Click on the 
Browse button to bring up a dialog of files on your computer to choose from.

Page in Project
If you have a multi-page project, choose this if you want the selected object to be a link to another page in your 
project.

None
Choose this if you do not want the selected object to be a link.

OK

Press this button to accept the changes made to the link properties.

Cancel

Press this button to cancel the changes made to the link properties.

Help

Press this button to get help on this dialog box.



Link Properties
Link Properties are used when creating a Web site from your project.    Using the Link Properties dialog box, any 
object on your project can become a link to another Web site, another page in the project, a file on your computer or 
an e-mail address.    You can also add invisible links by putting a clear rectangle with a border size of 0 on your 
project.



Acquire
Brings in images or photos to your project from any Windows® compatible scanner or digital camera.



Page Name Properties
When publishing your project as a Web site, it may be necessary to change the main page's name to either "index" or 
"default" and the extension to either "htm" or "html" using the Page Name Properties dialog box.    Contact your 
Internet Service Provider to see which name they prefer.



Page Name Properties dialog box
This dialog box is used to change page name properties of the main Web site page.

Main Page Name
Select either index or default for the name of the main Web page file.

HTML File Extension
Select either htm or html for the extension of the main Web page file.

OK

Press this button to accept the changes made to the page name properties.

Cancel

Press this button to cancel the changes made to the page name properties.

Help

Press this button to get help on this dialog box.



Publish To Folder
This brings up a dialog that allows you to choose the folder in which to create a Web site from the current project. 
You may need to consult your Internet Service Provider for more information on how to publish your Web site.



Preview Web Site
This brings up a preview of the Web site from the current project in your default Web browser. By previewing, you 
can make sure that all the objects appear correctly and the links work properly.



Select Source
This brings up a dialog that allows you to choose which scanner or digital camera to use to acquire images.



Choose Document Type/Description dialog box
This dialog box is where you change the type and/or description of a document.



Change Document Type/Description
This will allow you to change the document type and/or description of the current document.



AutoSave
Brings up a submenu that allows the user to set the AutoSave frequency.    The AutoSave frequency ranges from 
None to 10 minutes.    The current AutoSave frequency is shown in this menu item, and is checked in the submenu.



Field Object Input Order
Changes the input order of the field objects on the current page by bringing up the Field Oject Input Order dialog 
box.



Field Object Input Order dialog box
The Field Object Input Order dialog box allows you to change the input order of field objects.

Field objects on current page
This is a list of the field objects on the current page in their current input order.    You can drag and drop the field 
objects to change their input order.

OK
Press this button to close the dialog box and save your changes.

Cancel
Press this button to close the dialog box without saving your changes.

Help
Press this button to get help on this dialog box.



Comb Object
A comb object is used for written input on forms, where each character is written in a space of the comb.    The term 
"comb" is used because the object looks like a comb.



Add Comb Objects
Puts the program into Add Combs mode.



Field Object
A field object is used for input on forms.    Formulas can be used to calculate values to display in field objects.



Add Field Objects
Puts the program into Add Fields mode.



Export To PDF
Allows you to export the current document as a PDF file.



Edit Menu



File Menu



Object Menu



Personalize



View Menu



Window Menu




